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Attention John Doe:

Per your request the ltest specials in our industry are being made
available to you

These specials will be available only until June 12th

Jane

123 Main Plaza
Yourtown, USA

E-Mail sent using the Free Trial Version of WorldMerge, the fastest
and easiest way to send personalized e-mail messages. For more
information visit hitp:fwwnw. coloradosoft comfworldmrg
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WorldMerge has many powerful tools and features which allow you to manage your e-mails to large mailing lists.

· Automate e-mailing – up to 8,000 messages an hour.*

· Protect your contact list – your list of recipients will not appear in the cc: box.

· Personalize your message content with information from your source file. No more “Dear Valued Customer” messages!

· Send targeted mailing to a partial list of your contacts using the WorldMerge filtering tool or manual selection.

· WorldMerge Project Wizard guides you through the process quickly.

· Save and reuse messages and mailing projects.

· Use your existing database or source file – WorldMerge supports many file types; chances are your existing mailing list’s file format is supported.

· Save money – while maintaining direct control of your mailings. This program provides comparable services to a list server, but you won’t have to pay someone to manage it for you, nor maintain a dedicated Internet connection.

· Advanced features – send messages in text or HTML format with multi-part mime, send attachments, add your signature, and more!

*See Sending Your E-mail, below, which discusses factors affecting transmission speeds.
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About ColoradoSoft

ColoradoSoft creates e-mail management software, which it sells online at www.coloradosoft.com, along with other good e-business software of interest to ColoradoSoft customers. 

ColoradoSoft’s products are also sold by its many partners worldwide. If you or your company are interested in a partnering opportunity, see the information about our partnering program on our web site.
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About This Version

You can determine which version of WorldMerge you are using by selecting the Help menu, About WorldMerge option.  XE "version" 
A summary of the improvements made in WorldMerge 4.1 (versus 4.0):

· Graphics can be embedded in HTML-formatted e-mail

· Database can be changed after project is created (with limitations)

· Main screen can be accessed without going through wizard 

· Simplified Mail Server Settings configuration

· Prompts if the subject area is blank, or if attachment can’t be found

· Alternate Reply-To option available

· Keyboard commands available

· Improved error messages in Sent Items
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About this User’s Guide

This guide will help you get started using WorldMerge, and is designed to be a reference as you begin using it’s more sophisticated e-mail management features. This guide downloaded with your software or is available on your CD-ROM if you purchased WorldMerge after February 1999. If you are viewing it in Microsoft Word 95 or 97, you can take advantage of its internal hypertext to move to sections of interest to you. When you see your cursor turn from an arrow to a pointing hand, you can click to go to the location described in the text. For example, click to go to the TABLE OF CONTENTS, from where you can hyperlink to any of the headings listed.
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What is an E-mail Merge?

An e-mail merge works similar to the mail merges available from many word processing programs. There are three main ingredients to an e-mail merge:

· Database or source file – with contact information.

· Message – which may include inserted fields from the source file.

· An e-mail manager – WorldMerge – to link the source file and message, and to carry out mailings.

The minimum number of fields for your source file is one; you must include the e-mail addresses of your contacts. Often, your source file will include other fields, such as name, location, and other information specific to your business with these contacts. WorldMerge helps you create an HTML or text message to send to your contacts, which can be a simple form letter, or can contain personalized information from the fields in your source file. The e-mail merge occurs when WorldMerge sends your message to each of your contacts, merging the information from your source file into the locations in your message where there are merge fields, such as in the e-mail address location.

Your source file must have a minimum of one field – a field that specifies the e-mail addresses of your recipients.
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Setup Issues

Operating Systems Supported XE "operating systems supported" 
WorldMerge 4.1 has been tested to run on Windows 98, Windows NT 4.0, Windows 2000 ME, and Windows XP.

Purchase XE "purchase" 
To purchase WorldMerge, order online by clicking the Purchase button on WorldMerge’s start-up screen; from within WorldMerge by selecting the Help menu, Purchase selection; or by going to www.coloradosoft.com/order.cgi. Or complete the fax registration and order form that was saved in the WorldMerge folder during download. You can simply purchase the registration key to unlock the downloaded software, or you can purchase both the key and the software on CD, which will be mailed to you. ColoradoSoft will send you your key number at the e-mail address you provide on the registration form, and any CD purchase will usually arrive within seven business days (for most national and international locations). You will find that WorldMerge is a great value compared to competitive products! 

Installation XE "installation" 
You can download and install WorldMerge from the web site or purchase and install from a CD. In either case, you are installing the free evaluation version, which you can register upon purchase of a registration key. WorldMerge 4.0 and higher download to a different location from the 3.x  XE "version" versions, so you may keep both if desired.

Download from Web Site and Installation

Download the most recent version of WorldMerge from the web site; the wizard guides you through the download process. If you choose to save the executable to your PC, rather than running from it’s current location, note the name and location of the file. Then open the executable and the installation wizard will guide you through the install process.

CD Installation

Insert the WorldMerge CD into your CD-ROM drive to open the installation program.  Follow the instructions that appear on your screen to complete installation. If the installation program does not open automatically, you can start it yourself:

· Click on the START button (lower left-hand corner) and select Settings, then Control Panel from the menu. 

· Double-click the ADD-REMOVE PROGRAMS button in the Windows Control Panel.

· Click the INSTALL button on the Add/Remove Programs dialog box. 

· Follow the instructions that appear on your screen to complete installation.

Registration XE "registration" 
After purchasing WorldMerge, you will need to register, or unlock, your product using your registration key XE "registration key" 

 XE "key" \t "see registration key" 

 XE "unlock" \t "see registration key" . The start-up screen gives you the opportunity to register each time you start WorldMerge, until you do so. You will have to register your 4.1 unless you are simply upgrading from 4.0 (subsequent installations of upgrades generally do not require re-registration).
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The registration information sent to your e-mail address during the purchase process contains the registration key number as well as instructions on how to register. Should you have problems registering by using the method shown here, please use the alternate method described on the information sheet, or contact ColoradoSoft technical support at support@coloradosoft.com.

Until you register you are using the free evaluation version XE "free evaluation version" \t "see evaluation version" 

 XE "evaluation version"  and you will have the following constraints. First, each e-mail you send will have text at the bottom, informing the recipient that the e-mail was sent using WorldMerge:

E-Mail sent using the Free Trial Version of WorldMerge, the fastest

and easiest way to send personalized e-mail messages. For more

information visit http://www.coloradosoft.com/worldmrg

When you register with WorldMerge, this message will no longer appear at the bottom of each e-mail message. Second, until you register, a tracking number is placed at the end of your e-mail. This number allows ColoradoSoft to disable sending ability, which is necessary for ColoradoSoft to protect prospective customers and Internet users from unwanted spam associated with ColoradoSoft’s name.

Configuration XE "configuration" 
Prior to sending mailings with WorldMerge, you must complete configuration information so that WorldMerge knows what server to contact and can relay the necessary information to that server. WorldMerge will automatically open up the following windows, Identification Settings and Mail Server Configuration Settings, as needed; if it can locate information from previous installations it will do so.

Identification Settings
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Identify yourself as sender, with either your name or company. Identify the e-mail address from which you are sending; your ISP may require you to use an address which has the same server as the SMTP entry (the server is the part between the @ and the .com). If you wish to use an automatic signature XE "signature"  at the bottom of your e-mail messages, enter that signature in the space provided and make sure the box below is checked if you want the signature added to all new projects.

Signature can be entered as text or as HTML  XE "HTML formatting:signature" depending upon the type of project you intend to create. It may be best to leave out the signature line if you intend to alternate project types, as the signature will not automatically change.
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Identification settings affect newly created projects, so changes made here will be your new settings for all new projects.  The “From” text box in the Message window is populated at the time the project is first created, and will not change automatically; if you re-open an old project after you have changed your Identification settings, you will want to correct the entry in the Message window. 

Mail Server Configuration

Most users have an SMTP XE "SMTP"  server for outgoing mail. In this case, your SMTP server should be the server identified for you by your ISP (contact them if you are not sure of the correct entry). The usual format is: mail.yourISP.com

Should you use an ISP that does not provide an outgoing mail server, that limits bulk mailings, or if you have problems using your ISP’s SMTP, you can use the Direct Send XE "direct send"  option. Please note that this is a slower process than using an outgoing mail server, as WorldMerge must connect to each recipient’s mail server independently. Also note that since you are using servers that may not belong to your service provider, you may not receive undeliverable notices if the server is unable to complete delivery of the e-mail. WorldMerge will automatically attempt to locate your domain name server (DNS).

If you are using your ISP’s mail server, and it requires authentication XE "authentication, mail server" , select the type of authentication, then enter the appropriate information in the text boxes that are activated. If you do not have to enter username and password each time you send mail, nor have to check incoming mail before sending mail, chances are that you should leave the selection at the default “None.”

Select the appropriate internet connection type so that WorldMerge can apply configuration settings that will allow successful interaction with your server. 

Mail Server Configuration settings are global, and will affect all projects, current, new, and existing. 

The port defaults can be changed although this is generally unnecessary. Use the Default buttons to return the port settings to their default values of 25 (for mail server) and 110 (for POP server).

Internet Service Providers XE "internet service providers" 

 XE "ISP's" \t "see internet service providers" 
It does make a difference which Internet service provider you use. Free ISP’s tend to have more restrictive rules regarding mass e-mailings. Most pay-for-service ISP’s allow use of many e-business software applications, including WorldMerge. Please be aware that ISP’s have the right to change their server use rules at their discretion. 
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Database or Source Files

WorldMerge supports many sources of records; often these are databases, but they can take other forms. You can use address books, databases, spreadsheets, and properly formatted text or word-processing files as your source file. Chances are that your existing mailing lists will work just fine.

Unlike other e-mail management programs, WorldMerge does not import your source file. Only the link is stored within your mailing project; your source file is opened, read, and used from within your WorldMerge mailing project. Therefore, while you have a mailing project open, you will not be able to make changes to the source file, nor can you make changes to the source file from within WorldMerge. 

Your database can contain a maximum of 100,000 records. The minimum number of required fields in your database file is one, which must contain the e-mail addresses of your contacts.

The source file you have selected for the project displays on the Mailing List Window (see section below). The following types of changes to your database pose WorldMerge no trouble when reopening an existing project: editing records, adding records, or deleting records. The following types of changes will make it impossible for WorldMerge to reopen the project: changing the file name, changing the location where the database is stored, adding fields or deleting fields. You can change the database source for a project after its creation by clicking on the Database button on the Mailing List window. However, the new database must have the following in common with the original database: file type, and number and names of fields. See the Mailing List Window section below for more details.

Source File Types Supported XE "database file:types supported" 

 XE "source files supported" \t "see database file, types supported" 
While there are too many file types to list all of them (and more created each year), the following is a partial list of file types known to be compatible with WorldMerge.

Microsoft Access

Microsoft Excel

DBase

ODBC Data Source

Paradox

FoxPro

Eudora Address Book

Microsoft Outlook Address Book

Microsoft Outlook Express

TOP Producer*

ACT!*

Tab delimited text files

Comma delimited text files

*Files identified with an asterisk must be exported to text files.  See the following section for details.

Exporting to Text File XE "database file:exporting to text file" 
The following details conversion of information from some popular source files into compatible text files, as well as a generalized description for other source files.

Top Producer XE "Top Producer" 
1. Export via Setup, Export Data, ASCII File Export.  

2. Use the standard search method to pull the contacts wanted for export.  

3. Select which information to export on these contacts (select from database fields).  

4. The result is a comma delimited ASCII file.

ACT! XE "ACT!" 
1. From the File menu, select Data Exchange, then Export. 
(The Export Wizard starts, you will be responding to its dialog boxes.)

2. Select Text-Delimited from the choices in the File Type drop-down list

3. Use the Browse button beside the Filename And Location field to select your save location; click Save

4. Click Next.

5. Select the type of record you wish to export
(Contact records and Group records cannot both be exported in the same export file.)

6. Click Options. A) Specify the fields separator (delimiter) to be used; tab or comma is acceptable (comma is ACT!’s default). B) Specify that you wish to Export Field Names.  C) Click Next

7. Specify which record(s) to export, then click Next
(ACT! allows you to alter field order or export only certain fields.)

8. If you wish to use ACT!’s Map features (allowing you to save and reuse export map files), do so at this time, otherwise skip to the next step.

9. Click Finish to export the data.

 XE "database file:exporting to text file" Exporting Other Files to Text

If you are using a file type not listed above, export it to a tab or comma delimited text file. To do this, simply copy and paste into a text application such as Notepad, or save your existing document using Save As, and save as a text file (.txt). Look at your new text file from within the text application and make sure information is delimited with tabs or commas. When using a comma or tab delimited text file, the field names must appear in the first line of the file. Some programs do not provide the field names when exporting to a text file; in that case open up the text file and insert a new line at the beginning. Enter the appropriate field names separated by commas or tab, depending on the format of the records in the file.
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The Mailing Project Windows

Before you begin, you may wish to familiarize yourself with the appearance and features of the mailing project window. The mailing project window has a title bar, menu bar, and tool bar at the top, and the status bar at the bottom. The main area of the window is organized into three tabs: the Message window, the Mailing List window, and the Sent Items window. These three windows can be accessed by clicking the tabs, or from selecting from the Window menu. Different menu selections may be active or inactive depending upon which window is active. Immediately below is a summary of each window; detailed functionality available in each window is discussed by task in the remainder of this document.

Message Window XE "message window" 
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The Message window displays the e-mail message, and basic envelope information about your message, such as To, From, Subject, and any attachments you may have identified.

Mailing List Window XE "mailing list window" 
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The Mailing List window displays the information found in your database or source file. You can target your mailing by using the selections available in the Select Recipients button, or by manually clicking on records. Records selected for sending have an envelope icon beside them. After a send, status markers display here also, as a check or an “x” on the envelope icon.

Sent Items Window XE "sent window" 
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The Sent Items window displays the results of your sends for this project. Each record has a status marker, a time the send was attempted, and status details or description. You can save this log if desired, or delete any part of it. Subsequent sends within the same project will simply append sent items to the end of the existing list.
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Creating a New Mailing Project: The WorldMerge Project Wizard XE "project wizard" 

 XE "wizard" \t "see project wizard" 
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The WorldMerge Project Wizard leads you through the steps of creating a mailing project. Access the wizard at any time by selecting menu item File, and then selection New. Or, you can click on the new project button: 

Each of the dialog boxes in the wizard has four common features. 

	· 
	Next button: Allows you to proceed to the next step. WorldMerge prompts you with error messages if you attempt to proceed without providing required information.

	· 
	Back button: Allows you to retrace your steps in designing a project if you change your mind. 

	· 
	Cancel button: Allows you to exit the wizard without saving or completing the project. 

	· 
	Close button: In the upper right-hand corner of the dialog box, this allows you to exit in the same manner as the Cancel button. 


After your first project, WorldMerge will automatically populate the Project Wizard screens with the information you used on your most recently created project. 

Select HTML or Plain Text Message
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The first dialog box you will see looks like this: 

More information about how to create an HTML-formatted message is provided in the section Writing and Editing Your Message, below.

Select the Source File
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Next you must indicate the source file for your contact information. An image of this wizard dialog box follows. For more information on types of source files supported by WorldMerge, see the section on Source File Types Supported, above.

If you choose to type in the source’s path and filename in the Database Filename text box, the complete path and filename is required. 

If you choose to browse for your file, remember that you can select the type of file to browse for at the bottom of the browse dialog box, making your search easier if you have many files:
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You can now  XE "change:source or database file" change the source file for a project once it is completed. However, such changes are limited to databases that are the same file type, and contain the same fields. 

Identify the E-Mail Address Field
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Of paramount importance to WorldMerge is the list of e-mail addresses you are working with in this mailing project. In this step you identify which field in your source provides this information.  

If you have more than one field which contains e-mail addresses; such as “e-mail_home” and “e-mail_work” you must select one valid e-mail field at this time. After completing the wizard, you can  XE "change:To field, or e-mail address field" switch to another valid e-mail field by selecting from the drop-down list using the To button in the Message window.

Depending upon the type of source file you are using, you may be required to respond to other dialog boxes prior to seeing the one displayed above. For example, if your source is an Excel file with multiple sheets (i.e. a workbook), you will be asked to identify which sheet has your contact information. If you are using Microsoft Access or another database, a dialog box will prompt you to select the table or query that provides the information.

Finish

Congratulations! You have completed the wizard and can now save and view your mailing project.
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Save your work now! WorldMerge automatically prompts you to save at this point. You may save again at any time by selecting the File menu, and then the Save option, or use the Save button. If you do not save now, you will be returned to your prior project, if any, and this project will be erased.
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The default location XE "save, default location"  for saving your files is in the WorldMerge folder, or in the folder to which you last saved a project. However you can browse to the save location of your choice.  The default name of the file is WorldMerge, so remember to type in a file name that will bring to mind the specific project you created.

Once you have finished, you will see the main WorldMerge project window, displaying your current mailing project (See image below, in Writing and Editing Your Message). The next step is creating or editing your message, and making use of WorldMerge’s advanced tools for selecting target groups of recipients.  
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Writing and Editing Your Message

Writing your message is simple. After you have completed creating a new mailing project you will see the WorldMerge project window, with the Message window activated. Just click in the message space and type your text or HTML. If you have content from other documents you wish to use, you can copy from them and paste into the message area. 

Summary of Sample Message:
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To field contains field name corresponding to the one in your source file identifying the e-mail addresses of your recipients.

· From field contains your identification information from Identification Settings in the Settings menu, and can be customized.

· Subject line can contain text or inserted fields.

· Attach box can contain an attachment to go to all recipients, or an inserted field for custom attachments (both shown here, see Sending Attachments, below).

· Your message can contain text and inserted fields, and can be in plain text or HTML format (plain text shown here).

· This example has an automatic signature based on entries in the Identification Settings found in the Settings menu.

Once you have saved your mailing project, you can return to it at any time to edit the message content and fields, the subject line, and who the mailing will be sent to (see Targeted Mailings, below.) You can use an existing project as the basis for a new one to save time and effort; see Reusing a Mailing Project, below.

Remember to use the Preview Message option in the Message menu to see your message as your recipient will see it (see Previewing Your Messages).

Plain Text Messages XE "text messages" 
Plain text messages are simple, fast, and widely used. The example above is one such message. The WorldMerge message area may contain only ASCII characters. With plain text messages, the recipient’s browser, e-mail software, and personal preferences control font color and size and many other display characteristics. This means that you must use HTML formatting if you wish to control text XE "formatting (font, etc.)"  formatting (such as font size or line spacing) or insert graphics or colors. You can change from text to HTML formatting, or vice versa; select the Message menu, and then Options. To enter a text message, simply type it in, or paste from another application (it will paste in as ASCII text only).

HTML Formatting XE "HTML formatting" 
For those familiar with HTML formatting, you may enter your message in the message area of your mailing project in HTML format. You can select HTML formatting in the wizard during project creation, or change from text to HTML formatting, or vice versa, by selecting the Message menu, and then Options. HTML allows control of how the text appears to your recipients, such as font size, color, bolding, text centering, or displaying images. How your e-mail recipients see your HTML-formatted message still depends in part upon their browser and personal preferences. You may use any HTML-authoring program, and then cut and paste the HTML into the message area of the Message window.  XE "change:message format, HTML vs. text" \r "HTML_text" HTML e-mail can be personalized (see Adding Database Fields for Personalization, below). WorldMerge will automatically create and deliver a text message to any recipient whose browser will not accept HTML (multi-part capability). 

HTML for MS Word Users: Create the message in MS Word, then use Save As and select file type HTML. Then open the resulting file in Notepad, and cut and paste from there to the WorldMerge message area. XE "HTML formatting:using MS Word to create HTML" 
Images

 XE "graphics" \t "see images" 

 XE "images" 

 XE "HTML formatting:images" Images can be included in your HTML-formatted message in one of two ways. For embedded XE "images:embedded and referenced on server" \t "see HTML formatting"  graphics, you can reference the images in the HTML by path and filename. For example your HTML reference might look like:

<img src="C:\images\imagename.gif">

WorldMerge will attach this file to the e-mail automatically, and the recipient need not be online at the time the message is read to see the images.

Or, you may reference images residing on an active web server (see HTML Example, below). In this case the image itself is not part of the message, only its link is, just as with any web page. Any images referenced will be seen by recipients only if they are online at the time the message is viewed, and if the images are stored and referenced from a server location.

HTML Example XE "HTML formatting:example of" 
The following is an example of a message in HTML format, as it would appear in the message area of the Message window (note that this example references an image on a server):

<HTML>

<HEAD>

<TITLE>Your Title for this html document</TITLE>

<META Name=”keywords” Content=”words indicating this document contents, contents, etcetera”>

</HEAD>

<BODY>

<CENTER>

<IMG SRC="http://www.yourdomain.com/images/test.gif" WIDTH=100 HEIGHT=100><BR>

<FONT  SIZE=1 PTSIZE=6>This is a test; your text here.</FONT><BR>

<HR>

<P>Please note that in HTML physical placement on the page is not important – rather the tags such as the paragraph one at the beginning of this sentence tell the browser how to display the text.

<P>Please consult a reference document for more detail…or simply use your browser’s View menu, Source selection, and look at the source HTML behind your favorite web pages to learn more about writing HTML.

</BODY>

</HTML>

Editing Tools XE "editing tools" 
The Edit menu has the following selections: Undo, Redo, Cut, Copy, Paste, and Select All. These operate on the text of your mailing message as they do in most word processing programs. When deleting any inserted fields, take care to delete the entire field including it’s enclosing double-brackets. When you paste into WorldMerge, text will be converted to ASCII characters. To format text use HTML-formatted messages (see HTML Formatting, above).

Spell Check XE "spell check" 
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The Message menu has a Check Spelling option which can help you finalize your message. Or, use the Spell Check icon: 

Spell Check settings are set in the Settings menu, Spell Check option. In addition to basic spell check settings for capitals, numbers, and suggesting options, you can also load custom dictionaries other than the one provided by WorldMerge, or connect to the Internet and download other dictionaries from a third party. 

Hyperlinks XE "hyperlinks" 
Adding hyperlinks is easy; simply type the full URL (including the “http://”) in the message where you wish it to appear.  The recipient's e-mail software will handle the highlighting and linking of the URL when the message is read.

Adding Database Fields for Personalization XE "adding database fields for personalization" 
 XE "merge fields" \t “see adding database fields” 

 XE "personalizing" \t "see adding database fields" 

 XE "customizing" \t "see adding database fields" Once you have entered your basic message, in text or HTML, you can insert database fields, or merge fields, that will allow WorldMerge to insert specific information into your e-mail from each recipient’s source record. Keep in mind that you can only insert merge fields that exist in the source file you selected for this mailing project. 

All available fields from your source file will display in the drop down list using any of the following methods: 

[image: image27.png]3 WorldMerge - EX4_1.pri [_[O]x]
File Edt Send Message Settings Window Help

DSHE /-8R B8](vR
Wesage | Mainglin | Sentlems |
o [[Eeam
|
S

[Ready [05ekoted





· Click on the Insert Database Fields button:  

· Right-click in the message area.

· Click on the To, From, or Subject buttons.

· Select the Message menu, then select Insert Merge Field.

Select the desired field from the drop down list. The inserted field will appear within double brackets at the insert location, as follows: [[fieldname]] Examples of this can be seen in the sample message at the beginning of this section, Writing and Editing Your Message.
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Message and Project Control Options

In addition to the basics of writing and editing your message, you can control other aspects of your message and project.

Word Wrap XE "word wrap" 
If you have selected to send a text message, keep in mind that some browsers will not wrap lines, such as some versions of Netscape Email, and will instead display your message as a single long line of text! If you are concerned about this, use the Word Wrap feature. Access it via the Settings menu, Message Settings selection. The Wrap Long Lines feature will force a carriage return after a certain number of characters in your message (you can select how many). Use this feature to control what your recipient will see, regardless of variations in browsers.

CC and BCC XE "cc" 

 XE "bcc" 
This feature is not available in Direct Send mode, only when using an SMTP server (see Mail Server Configuration, above).

Using the carbon copy (CC) and blind carbon copy (BCC) functions requires an entry into the To text entry box of the Message window. These entries follow the bracketed field that identifies the field in your source file that contains your recipients’ e-mail addresses, and are separated by commas. The following is an example of the contents of the To text entry box:

[[EMAIL]],cc:name@isp.com,bcc:[[BCC_EMAIL]]

In the above example, [[EMAIL]] is the field from the source file identifying the recipients’ addresses, “name@isp.com” is the individual who will receive a carbon copy, and [[BCC_EMAIL]] is a field in the source file containing e-mail addresses to whom blind carbon copies will be sent.

Here is another example: 

[[EMAIL]],cc:name@isp.com,bcc:anothername@isp.com

In this example, two e-mail addresses have been entered for the CC and BCC, and no fields from the source file were used.

WorldMerge creates and sends each e-mail message separately. Therefore the CC and BCC recipients will receive a copy of each e-mail sent. It may be better in the case of large sends to simply add the person(s) in question to your source file to avoid sending them a large number of messages.

Sending Attachments XE "attachments" 
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You can send attachments with your e-mail message. Access this option by selecting the Message menu item, then the Insert Attachment option; or by clicking on the Insert Attachment button. You may send the same message to all selected recipients, or you may send customized attachments for each recipient. 

You can attach a maximum of 20 files per recipient, whether you are sending the same or customized attachments.

Same Attachment to All Recipients

If you select to send the same attachment to all recipients, you will be asked to identify the attachment’s path and filename using a standard browse window. When you have selected your attachments, you will see the path and file name of the attached file(s) listed in the Attachments text box, such as:  C:\My Documents\fares\Sales.xls  In this example, “Sales.xls” is the actual document name of the file you attached. If you have selected multiple files, a semicolon and a space will separate them, as follows:  C:\fares\Sales.xls; C:\first.doc
You will receive a warning prompt if WorldMerge is unable to locate the attachment at the time of send.
Customized Attachments
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If you select to send customized attachments, the complete path and file name must be included in a field in your source file, with a valid entry for each recipient record. Each recipient will receive the attachment specified in this field in their record. If you send multiple custom attachments, they will appear listed in the Attachments text box separated by a semicolon and a space, as follows: [[file_1]]; [[file_2]] See also the example attachments in the sample window shown above, in Writing and Editing Your Message.

Other Message Options

Message Menu

The Message menu has a number of control options, other than those covered above. The Preview selection is covered in the section below titled Previewing Your Messages. The Options selection allows you to change settings for plain text versus HTML messages, as well as add an alternative Reply To XE "reply-to, alternate"  or add User Header Entries (see the section below Advanced Features). You can also control the Delivery Options; requesting a read receipt XE "read receipt" , or setting the importance level XE "importance level"  of your message (these features are handled by the recipient’s browser and personal preferences, and therefore vary).

Settings Menu

Likewise, the Settings menu has a number of control options, other than those covered above. In Message Settings selection, both text and HTML-formatted messages can be encoded. No encoding XE "encoding"  is the default value, Quoted-Printable is typically for text, and Base64 for binary data. The International Settings XE "international settings" 

 XE "language settings" \t "see international settings"  box is defaulted to English, non-English users can identify another setting; visit http://www.czyborra.com/charsets/iso8859.html for information. For more on Word Wrap, see the section on that topic, above. Basic settings for Spell Check are in this menu also (see Spell Check, above).
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Reusing a Mailing Project
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From within WorldMerge, select menu File and then Open from the drop down menu to open an existing mailing project.  Or use the Open button:

If you cannot open an existing project, make sure you have not moved the source file! The source file is accessed by following its path as stored in the project file, which will be incorrect if the source file has been moved. Either return it to its original location, or recreate the project. WorldMerge will also be unable to open your project if you have made the following types of changes to your database: adding new fields, deleting fields, or changing the file name. Adding, removing, or editing records will not disrupt WorldMerge’s ability to access the database.

WorldMerge projects will open as text-only files if not opened from within WorldMerge. 

You may reuse a mailing project, such as by selecting a new target group of recipients from within the same mailing list (i.e. by using Filter, see section below), and save the project as a new project (select menu File and then option Save As). This can be useful for carrying out repetitive tasks, such as sending an annual reminder to renew membership. You can also change XE "change:source or database file" 

 XE "database file:changing" \t "see change, source or database"  the source file accessed by a project if the new database is the same file type (i.e. both files are MS Excel) and if the files contain the same field names. This is useful for those who have multiple, identically formatted databases, such as leads for the month, or client lists divided into multiple databases. Otherwise, you must start a new project and can cut and paste in the message from another project, if desired.
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Previewing Your Messages

If you used database merge fields or are sending an HTML message, this is an especially useful way to see what your message will look like to those on your mailing list.

Preview Message will display the message for each selected contact in your source file.   Unselected recipients will not be displayed. 

Select the Message menu, and then the Preview Message choice. Or, use the Preview Messages button. [image: image35.png]3 WorldMerge - Shorttest.pri
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You can preview your messages by scrolling through them using the navigation buttons: First Record, Previous, Next, and Last Record.

Plain Text Message Preview XE "preview:text message" 
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This figure shows an example of how a plain text message will appear in Preview. 

HTML-Formatted Message Preview XE "preview:HTML message" 
In the case of previewing an HTML message, use the navigation buttons until the record you want to view is displayed, then use the HTML Preview button. 

[image: image37.png][WorldMerge Project Wizard

Thase are althe answers the WordMerge
Wizard needs o create you new slectoric
mai merge prject.

Yo can now erter your exmail message,
selectteciperts, and send your message.

Cancel | < Back [[Fieh ]




[image: image38.png]|- Message Setings

Message Format:

ReplyTo Address:

User Header Entres:

|- Delivery Dptions.

T~ Request a read receiptfor this message





WorldMerge will launch your default browser to display the page.  XE "images:in message preview" Please note that unless you are online, images referenced from servers will not be able to be retrieved for display. To view a different record, return to WorldMerge (make it the active window on your screen) and navigate to the next record you want to view, and use the HTML Preview button again; it will refresh your open browser window with the new record.

The HTML Preview button is active only if you have selected HTML during creation with the Project Wizard, or selected HTML formatting in the Options Menu (see Message Menu, above).
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Managing the Mailing List

The Mailing List window allows you to view your database or source records, and identify those on your list to whom you will send. You may want to send to all those listed, or may want to send to only some of those on the list. If you have individuals who requested that you not sent them mail, it would be wise to place them on your exclusion list. 

WorldMerge does not import your data from your source file. Therefore you cannot make  XE "change:database records" changes to your database from within WorldMerge. Nor can you access your database to make changes while a WorldMerge project is open which uses it as its source file.

Targeted Mailings XE "targeted mailings" 
WorldMerge has a number of tools to allow you to send your mailing to a select group of recipients. Potential recipients for your mailing are shown in the Mailing List window. However, you may not want a particular mailing to go to your entire mailing list. You can unselect certain records and send only to those that remain selected. 
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Selected records have an envelope icon beside them, and unselected records will have no icon. After a send, this icon will appear with a status marker superimposed upon it to indicate the success or failure of the send to that recipient (see Sent Items Window, below, for more on status markers).

Basic Selection Tools

You can manually select or unselect recipients by simply clicking on the desired record in the Mailing List window. Selected recipients will have an envelope next to the record. Also, the Select Recipients button allows you to use the following functions: Select All, UnSelect All, Select Failed, Unselect Successful, and Invert buttons, or Filter. The last of these is discussed in greater detail below. Select Failed is useful for resending only to those for whom the previous send failed, so that duplicate mail is not sent to recipients for whom the send was successful. Similarly, Unselect Successful allow you to unselect the recipients whose mail was successfully sent, leaving selected all those with status markers indicating failure as well as those to whom the message was never sent (as in the case of a halted send, or loss of ISP connection).

Filter XE "filter" \t "see targeted mailings" 
You can use the filter tool to quickly select which recipients you wish to include in your mailing, based on the fields in your source file. Click on the Select Recipients button to access the Filter pop-up box, seen in the diagram below. 

The selection “Valid e-mail address” checks to see that the entry is in valid format; that it includes the “at” symbol ( @ ) and a dot (.)  The “Send failed “x” entries XE "failed \“x\” entries" ”  XE "x's:resending" \t "see failed \"x\" entries"  selection allows you to retry failed mailings only, without re-sending to those recipients who already received your mail (make sure not to delete status markers before using this tool).

After using the filter tool, you can review selected records, and then manually include or exclude specific records as needed. (See Basic Selection Tools, above). You may also apply a number of filter criteria in succession to add to your list of selected recipients. Note that filters will not be cumulative if you have put a check in the “Unselect all recipients before applying query” box! If you check this box, Worldmerge unselects your entire database prior to applying the filter, so that the only recipients selected are those that satisfy the filter currently being applied.
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Filters are case sensitive!

Exclusion List XE "exclusion list" 
Select  XE "unsubscribe" Exclusion List from the File menu to access this feature.

This is a convenient location for you to keep a list of individuals who have requested to be excluded from your mailings. Entries should be formatted as e-mail addresses, such as:  jdoe@aol.com. An entire group can also be de-selected. For example, if you wish to exclude all contacts with e-mail addresses at AOL, enter:  *aol.com

Add to this text file when a contact indicates that he or she does not wish to receive mailings. When you send mailings, addresses in the exclusion list will be automatically unselected by WorldMerge.

The exclusion list is a single file in your WorldMerge folder, and therefore is not specific to a single mailing project, but rather is accessed and applied when you send any project. Note that the exclusion list must be left in its default location in order for WorldMerge to locate it during a send.

Sending Your E-mail

You can control how your message is sent, as well as when. In addition, you can control other aspects of your send. You can initiate your send from within WorldMerge, from within a DOS window or from inside another program. Also, you can control when a send starts, as well as manually stop a send. Results of your send are posted to the Sent Items Window, which is discussed below.

Transmission  XE "speed of send" rates are in part determined your service provider, mail server use versus Direct Send mode, mail server load, time sent due to varying traffic on the Internet, and your own hardware, such as modem.

Before you send your message, remember to save your mailing project

Send XE "send"  Message

To immediately send your message, select menu item Send, and option Send Message, or use the corresponding button on the toolbar:  

WorldMerge will first notify you of the number of recipients in the current send, and ask you to confirm your desire to send. Once confirmed, it will commence sending e-mails, displaying percent complete in the status bar, and status markers both in the Mailing List window and the Sent Items window. 

Schedule a Send XE "schedule a send"  

You can determine when a mailing is to be sent. Select menu item Send, and then option Schedule Send, or use the Schedule a Send button. You will need to respond to the simple dialog box that appears, as shown below, to set the time for your send. Any scheduled send will be displayed in the status bar. Other guidelines for scheduled sends are:

· Only one send can be scheduled at a time.

· WorldMerge must be left running until the time of the send (can be minimized).

· Your computer must be connected to the Internet at the time of the send.

If the current date and time displayed is not correct, your send won’t be when you want either! Correct your computer’s clock.

Halt Current Send XE "halt current send" 
If for any reason you wish to stop a send, you can select menu item Send, then option Halt Send; or simply click the Halt Current Send button. 

A pop-up box will notify you that the send was halted. If you select Send again, a pop-up box will give you the option to start from the last successfully sent record, to avoid duplicate sending.

Multiple recipients’ messages may be sent simultaneously depending on your internet connection type; therefore a number may be in progress at the time you hit the Halt button. No more messages will be sent, but those already sent will be posted to the Sent Items window with status markers.

Sent Items Window

The Sent Items window provides information about what occurred during a send. Each recipient is listed, with a message status marker, time of send, and status details. The list can be cleared by using the Delete All button, or individual records can be deleted. To delete individual records, select the record(s) in question, and use the Delete button. Note that the Control button can be used when selecting various individual records for deletion, and the Shift can be held down to select a contiguous group of individual records for deletion. The Sent Items information can also be saved.

There is no Undo function for Delete and Delete All!

Message Status

The  XE "status markers" 

 XE "x's:x's, red" \t "see status markers" 

 XE "checks, green" \t "see status markers" status of each recipient’s message will be updated as the mailing progresses. If the message could not be sent, a red X will appear by the recipient’s name. If the message was successfully sent, a green check  will appear. Any e-mail addresses you had included in your exclusion list will have been excluded from the mailing, and will have no status marker beside the associated record. These status markers will also appear on the Mailing List Window (see that section above for more information). See the Filter section, above, if you wish to try to re-send to those recipient records marked with a red X.

Status

The Status column displays information about the send attempt for each record. “Failed” means that the message was not able to get to the server. “Message Sent” indicates that the mail server identified in mail server configuration settings accepted the message for delivery. If the mail server accepts the e-mail for delivery, there is no further communication between the mail server and WorldMerge; should the server have subsequent difficulty delivering the mail, such information would not be available to WorldMerge. Instead your ISP’s mail server (if used) may send you an undeliverable mail message to your regular e-mail account, according to its service agreement with you. See the section above on Mail Server Configuration for information about what server is being used and the various choices available. See Troubleshooting, below, for more information on the different errors that may be encountered here. Should you contact ColoradoSoft for help with an error, please supply the text of the exact error in question for reference by the technical support person.

Save Report of Sent Items

You may  XE "reports" 

 XE "log, of sends" \t "see reports" save the report of sent items at any time. You can first edit the list in the Sent Items Window using the Delete button if desired. Then use the Save button; make sure to name it with reference to project and date for ease of reference later. 

The saved file is a text file which shows the send status for each record, summarized as follows:

0,jdoe@abc.com,Mon 06/18/2001 12:05 PM,Failed

1,jsmith@def.net,Mon 06/18/2001 12:06 PM,250 LAA05433 Message accepted for delivery

Initiating a Send from Within Another Program

In order to do this, you must specify the full path to the WorldMerge executable file (worldmrg.exe), and the full path to the mailing project you wish to use. The command line syntax is as follows:

C:\Path\worldmrg.exe [-merge or –project]

C:\Path\ProjectName.prj [-exit]

(“-exit” optional; use if you want WorldMerge to exit when task complete)

To open a project and do a Send Merge:

worldmrg.exe –merge C:\FILES\My.prj

To open project and wait for user interaction:

worldmrg.exe –project C:\FILES\My.prj

To open project and do a Send Merge, then exit:

worldmrg.exe –merge C:\FILES\My.prj –exit

Advanced Features

User Header Entries XE "user header entries" 
WorldMerge allows users to add e-mail header information, allowing a different Reply-To, among other things. Access this feature through the Message menu XE "reply-to, alternate" , Options selection.

Deleting a Mailing Project XE "deleting a project" 
Should you wish to delete an obsolete mailing project, you will do this using your File Manager or Explorer. When deleting, make sure to remove all files for the project; there will be one WorldMerge message file and three text files associated with each project. 

Depending on your viewing preferences, a project you saved as “flowers” would appear something like this:

If you do not delete all files, you may see the “flowers” project listed when you try to open an existing project from within WorldMerge, however you may get an error message if you try to open it.

Troubleshooting

	Problem
	Possible Solutions

	Registration not accepted.
	Proxy servers do not allow you to use the standard registration process. Instead, follow the alternate instructions provided in the information that accompanied your registration key.

	Can’t find Registration Key.
	If you purchased directly from ColoradoSoft, you can e-mail us with a request to re-send your key. Please provide the following information by which we can search our database: licensee name, address, phone, e-mail, or order number. If you purchased through a reseller, they will have your information rather than us; contact them directly.

	CDAOException error 

OR

Can not find installable ISAM

(Typically when identifying the source as an Access or Excel database file.)
	This is usually solved by reinstalling the MS Office software, and selecting the repair option (1997) or choosing all MS data access options for installation (2000).

	First record appears in field title bar of Mailing List Window.
	See “Not sending to first record”; cause is same.

	Formatting is lost when pasted to message area.
	WorldMerge message area only allows ASCII characters. To format your message, send in HTML format (see HTML Formatting, 14).

	Records whose addresses are on my exclusion list still show up in Preview mode.
	That is true, but any address on your exclusion list will not be sent to at time of send.

	I can’t see my graphics in Preview.
	See HTML-Formatted Message Preview, page 19.

	Some of my recipients can’t see HTML messages.
	Some recipients, such as @aol.com recipients, may not see HTML mail properly. When you send using an HTML-formatted message, WorldMerge also creates an alternate text message that is sent when the recipient’s browser doesn’t accept HTML. 

	All Red x’s
	See “’Failed’ in status column on Sent Items window,” below.

	Red x’s after some green checks.
	Sporadic red x’s can be due to incorrect e-mail addresses in your source file. A pattern of red x’s can be due to incorrect connection type identified in Settings> Mail Server Configuration.  If you have some green checks, then all red x’s, it is likely that your mail server is getting jammed or is limiting sends; see Mail Server Configuration, on page 6. Note that WorldMerge has a limit of 100,000 records in your source file.

	I changed my configuration settings and it still doesn’t work.
	Please note that while most settings are global and apply immediately and to all projects, the Identification Settings are used to populate areas of the Message window at the time the project was created; you may need to manually change the “From” field (which can affect sending), and any signature line information that you wish changed.

	Not sending to first record.
	Your first “record” or line of the text file used as your source record must be the field names. Here are sample lines from a comma-delimited text file:

Email, First, Last, Title

jdoe@abc.com, John, Doe, Mr.

jsmith@def.net, Jane, Smith, Dr.

mgreen@ghi.org, Mel, Green, Ms.

And the same excerpt, tab-delimited:

Email
First
Last
Title

jdoe@abc.com
John
Doe
Mr.

jsmith@def.net
Jane
Smith
Dr.

mgreen@ghi.org
Mel
Green
Ms.

	500 – 550 errors in Sent Items window.
	Mail server did not accept message for delivery. These are common solutions:

· See Mail Server Configuration, page 6 regarding possible restrictions for your entries in the configuration box as well as the To field. 

· Make sure the From field on the Message window contains the field name that holds the e-mail addresses of your recipients, such as [[email_address]]

· Control characters from a word-processing program may interfere with server function; try copying message text to Notepad (to view and eliminate any such non-ASCII characters) and then cut and copy into WorldMerge message area.

	10000 series errors (10000 and above)
	This error can indicate:

· No online connection at time of send

· Incorrect entry in the SMTP area in Mail Server Configuration
· “To:” field in Message window is not properly formatted i.e [[fieldname]] where fieldname is name of field in your database that contains the e-mail addresses. You should NOT see an actual e-mail address in the “To:” field. See also “Not sending to first record” regarding missing field names.

· “From:” field in Message window is not properly formatted or is rejected by your server as a non-user (see Mail Server Configuration, above).

	“Failed” in status column on Sent Items window.
	This indicates that WorldMerge could not connect with your server. Check that you are online, and have the correct server address (see Mail Server Configuration, page 6). If you have some green checks and also red x’s see “Red x’s after some green checks,” above. 

	No errors received but no mail received either.
	This can be caused by your return address and SMTP not being on the same server.  This can also result from using Direct Send mode; the recipients’ ISP’s have no service agreement to notify you of failed sends, unlike your own ISP who may, if you instead were using its mail server. See Mail Server Configuration, page 6

	‘Relaying denied’ or ‘not a gateway’ error messages.
	You may have identified the wrong server in the SMTP area, or not completed the authentication area correctly (see Mail Server Configuration, page 6). Also, some servers, such as Exchange Server require certain settings to allow software such as WorldMerge to send through them (see Exchange Server, below).

	Exchange Server
	Configure MS Exchange Server as follows: accept SMTP e-mail, relaying enabled, and relay agent must be open at time of send.

	Don’t want to leave Internet connection open until scheduled sent time.
	WorldMerge does not open your Internet connection. However, autoconnect is a feature that can be enabled in your Windows set-up; you may want to consult your Windows Help to locate information about this.

	If I reinstall WorldMerge will I lose projects?
	No. Also, if you are reinstalling 4.x over the same or an earlier 4.x version, you will not have to re-enter your settings, nor re-register.

	I open my projects from Explorer and get garbled text files.
	WorldMerge projects must be opened from within WorldMerge. First open WorldMerge, then go to File menu, select Open, and locate your file.

	Why is there text at the bottom of every message (ad material)?
	Until you purchase WorldMerge, this is the case. See Registration, page 5, or Purchase, page 4 for more information.


Keyboard Commands XE "keyboard commands" 

 XE "hot keys" \t "see keyboard commands" 
How to Use Keyboard Commands: 

The tables below list the keyboard commands that allow access to all menus, menu drop-down selections, and main window buttons. Some functions can be accessed from the keyboard in more than one way. These methods are provided for those who prefer the keyboard to the mouse, as well as for the visually challenged. There are other pop-up boxes with functions that have keyboard commands or hot keys associated with them. The letter underlined in the button title is generally the key to be used in conjunction with the Alt key (i.e. Alt+[letter]) to access the functionality from the keyboard. 

Example: To open a new project using keyboard commands, hold down the Alt key then press the F key, (then release Alt and F), then press the O key. Or, hold the Ctrl key down and press the O key.

Selection Availability:

Some selections are not available at all times: for example Edit menu commands are available when the Message window is active, and Cut and Copy are only available when text is selected.

Navigation and Selection Tips:

· Check or uncheck boxes using the Space Bar.

· Move among text boxes or buttons using the Tab key.

· Move among dropdown selections in menus or text boxes using the arrow keys.

· Navigate among recipients in Mailing List using the arrow keys.

· Navigate among Sent Items listings using the arrow keys.

· To close a drop-down menu or pop-up box, use the Escape (Esc) key.

Menu and Menu Drop-Down Keyboard Commands:

	Menu Selection
	Keyboard Command
	Sub-selection
	Hot key
	Alternate Hot Key for this Sub-selection

	File
	Alt+F
	New
	N
	Ctrl+N

	
	
	Open
	O
	Ctrl+O

	
	
	Save
	S
	Ctrl+S

	
	
	Save As
	A
	

	
	
	Exclusion List
	E
	

	
	
	Exit
	X
	

	Edit
	Alt+E
	Undo
	U
	Ctrl+Z

	
	
	Redo
	R
	Ctrl+Y

	
	
	Cut
	T
	Ctrl+X

	
	
	Copy
	C
	Ctrl+C

	
	
	Paste
	P
	Ctrl+V 

	
	
	Select All
	S
	Ctrl+A

	Send
	Alt+S
	Send Message
	M
	

	
	
	Schedule Send
	S
	

	
	
	Halt Send
	H
	

	Message
	Alt+M
	Preview Message
	P
	

	
	
	Insert Merge Field
	M
	

	
	
	Insert Attachment
	I
	

	
	
	Check Spelling
	C
	

	
	
	Options
	O
	

	Settings
	Alt+T
	Mail Server Configuration
	M
	

	
	
	Message Settings
	E
	

	
	
	Identification Settings
	I
	

	
	
	Spell Check
	S
	

	Window
	Alt+W
	Message
	M
	See more commands by window, below.

	
	
	Mailing List
	L
	

	
	
	Sent Items
	S
	

	Help
	Alt+H
	WorldMerge Manual
	W
	

	
	
	Online Help
	O
	

	
	
	Purchase
	P
	

	
	
	About WorldMerge
	A
	


Window Button Keyboard Commands:

	Active Window
	Button Title
	Keyboard Command
	Sub-selection
	Hot key

	Message Window XE "support" 
	N/A
	
	
	

	Mailing List Window
	Select Recipients
	Alt+R
	Select All
	S

	
	
	
	Unselect All
	U

	
	
	
	Select Failed
	F

	
	
	
	Unselect Successful
	N

	
	
	
	Invert
	I

	
	
	
	Filter
	L

	
	Clear Status
	Alt+C
	
	

	
	Change Database
	Alt+D
	
	

	Sent Items Window
	Delete
	Alt+D
	
	

	
	Delete All
	Alt+A
	
	

	
	Save
	Alt+V
	
	


More Help

Still have questions?  If you are online, use the Help menu’s Online Help button to access ColoradoSoft’s web site. Or visit the ColoradoSoft web site at www.coloradosoft.com and look at the page on frequently asked questions (FAQ), or from within WorldMerge select Contents from the Help menu.  If you do not find an answer there, you can contact ColoradoSoft at www.coloradosoft.com/support.htm and describe your problem in the form provided; when writing regarding an error message, please supply the text of the exact error in question for reference by the technical support person.

Index



ACT!, 8

adding database fields for personalization, 15

attachments, 17

authentication, mail server, 7

bcc, 16

cc, 16

change

database records, 20

message format, HTML vs. text, 14

source or database file, 12, 18

To field, or e-mail address field, 12

checks, green. see status markers

configuration, 6

customizing. see adding database fields

database file

changing. see change, source or database

exporting to text file, 8

types supported, 7

deleting a project, 24

direct send, 6

editing tools, 15

encoding, 18

evaluation version, 6

exclusion list, 21

failed “x” entries, 20

filter. see targeted mailings

formatting (font, etc.), 14

free evaluation version. see evaluation version

graphics. see images

halt current send, 22

hot keys. see keyboard commands

HTML formatting, 14

example of, 15

images, 14

signature, 6

using MS Word to create HTML, 14

hyperlinks, 15

images, 14

embedded and referenced on server. see HTML formatting

in message preview, 20

importance level, 18

installation, 4

international settings, 18

internet service providers, 7

ISP's. see internet service providers

key. see registration key

keyboard commands, 27

language settings. see international settings

log, of sends. see reports

mailing list window, 9

merge fields. see adding database fields

message window, 9

operating systems supported, 4

personalizing. see adding database fields

preview

HTML message, 19

text message, 19

project wizard, 10

purchase, 4

read receipt, 18

registration, 5

registration key, 5

reply-to, alternate, 18, 24

reports, 23

save, default location, 13

schedule a send, 22

send, 22

sent window, 10

signature, 6

SMTP, 6

source files supported. see database file, types supported

speed of send, 22

spell check, 15

status markers, 23

support, 29

targeted mailings, 20

text messages, 14

Top Producer, 8
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Sent Items list management tools





Status detail





Most header information isn’t seen by the end-user. You can enter as many e-mail header entries as you wish.





Buttons allow targeted mailings, clearing status markers from previous mailings, and database changes. 





Date and time sent





Status marker





The field names that appear here are those found in your source file.


Select the one that corresponds to your contacts’ e-mail addresses.





Status bar





� EMBED Word.Picture.8  ���





This is the HTML-formatted message.








Click the Use the Free Version button to continue without registering.





Click Purchase to activate your browser and go to the online purchase web page.





Click the Enter Registration Key button to continue with the registration process.





Your key number is sent to the e-mail address you provided on the registration form completed at time of purchase, it is also sent with any CD purchase.





This opens Notepad to view the alternate text message








Title Bar





Your database or source file displays here.





Status bar





Tool Bar





If you select HTML, you will enter HTML code into the message area. You may type it in, or cut and paste HTML created with another program.





Most browsers will send replies to the address indicated here, which becomes part of the header information. This can be different from the “From” information you provided in the Identification Settings area of the Settings menu.





Windows tabs





Status bar





Title Bar





Tool Bar





Menu Bar





Message area: Your message to recipients is entered here.





Attachments will be listed here





Subject area





Title Bar





Type in the source’s path and filename, or use the Browse button to locate your file.





Select a type of source file from the drop down menu.





Select the appropriate file type from the drop down, in order to display only that type of file in the browse window.





…instead of all types, as seen here.





Tool Bar
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You will be asked to identify which field in your source document contains the path and file name of the customized attachment.








The source file must include a field that contains the complete path and filename of the attachment you wish to send.  








Information about you, the sender





Choices include:


Equals


Does not equal


Contains


Greater than


Greater than or equal 


Less than


Less than or equal


Valid e-mail address


Send failed “x” entries





Selections available in the drop down box are the same as the fields available in the project’s source file





Windows tabs





Make sure your selection criteria are suitable for accurately identifying the records you want in your mailing.  Consistency in your source file is valuable here.








Windows tabs





Field identifying e-mail addresses





If you select Plain Text, you will simply type your message into the message area of the project window.





This is the HTML preview.





Where your fields appear in your project, you now see the actual data populating your message, for the record you are currently viewing.





If you haven’t registered you will see this copy at the bottom of your e-mails.





If you haven’t registered you will see this copy at the bottom of your e-mails.





Menu Bar





Menu Bar





Your potential recipient records are displayed here.
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